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 1.  Introduction
The Tgi3D® CT (Tgi3D® SU PhotoScan Calibration Tool) is a photogrammetry software that facilitates an 
interface  to  mark  matching points  on  multiple  images for  camera  calibration  and  taking measurements  
between the marked points. The Tgi3D® CT Reference Guide contains all the reference material pertaining to 
the program.

Note for Mac OS X Users: Effective usage of the Tgi3D SU PhotoScan Calibration Tool requires a 3-button 
mouse.  If  you  do  not  have  a  3-button  mouse,  we  recommend  you  to  use  a  program  like  
KeyRemap4MacBook (http://pqrs.org/macosx/keyremap4macbook/) to generate scroll wheel, middle-button 
and  right-button  click  events  (e.g.  command-control-cursormove,  command-click  and  control-click 
respectively).
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 2.  Tgi3D® CT User Interface
This section of the reference guide covers the Tgi3D® CT user interface, including menus, tool bars, dialog 
boxes, and the drawing and viewing area.

 2.1.  Application Window
Main parts of the Tgi3D® CT application window are title bar, menu bar, tool bars, (dockable) project window, 
the 3D drawing and viewing area.

Following is an image of the Tgi3D® CT user interface on Microsoft Windows: 

 2.2.  Title Bar
The  title  bar  at  the  top  of  the  application  window  contains  the  standard  Microsoft  Windows  controls 
(minimize, maximize and close) on the right, and Tgi3D® CT edition and version identifier with the name of 
the currently opened project on the left. 

 2.3.  Menu Bar
Menu bar  is  located below the title  bar.  The majority  of  Tgi3D® CT tools,  commands,  and settings are 
available within the menus found in the menu bar. The menus on the menu bar are File, Edit, View, Tools, 
Window, and Help.
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 2.4.  Tool Bars
Tool bars appear below the menu bar. Each tool bar contain a set of related controls. By default the Tgi3D ® 

CT includes the File, Edit and Zoom tool bars. You can toggle the visibility of the tool bars by clicking the right 
mouse button on the toolbar and menu bar area and checking or unchecking the tool bar name on the  
context menu that appears.

 2.5.  Project Window
By default, the “Project Window” appears docked on the left side of the Application Window. It facilitates 
navigation  through  the  images  used  in  the  project,  provides  information  on  the  current  status  of  the  
calibration project and displays technical image and camera information of the selected photograph. It has 
three pages: “Photo files”, “Point errors” and “3D Model”. Under “Photo files” page, you can navigate through 
the images in the current project. “Point errors” page reports the model mismatch errors of the last camera 
calibration process. Clicking on the “3D Model” tag will  switch to 3D viewer displaying the reconstructed 
points overlaid on the photograph and “3D Model” page will display the calibrated camera  names (i.e. image  
titles) in the 3D model. The Image Info is displayed on the bottom side of the project window.

The project window can be shown and hidden by clicking the right mouse button on the toolbar and menu 
bar area and checking or unchecking the “Project  Window” item on the context menu that appears. Both the  
project window and the image info section inside it can be shown an hidden by checking and unchecking  the  
corresponding items in the View menu.

To dock or undock the project window, click and hold the left mouse button on the Project Window title bar  
and move it. Screen shot of an undocked project window is shown below.
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 2.6.  Drawing and Viewing Area
The Drawing and Viewing Area is a collection of sub-windows containing the image and the calibration points 
or the 3D model.  The area is marked with dotted lines in the figure below. The sub-windows could be  
accessed via the selection tabs on the upper side of the area as shown on the left below. The window menu 
and the project window can also serve the same purpose. 

There are two types of sub-windows in the Drawing and Viewing Area

1) Image viewer, which displays and facilitates drawing of calibration points in 2D.

2) 3D viewer, which displays the reconstructed points in 3D and facilitates

• entering a distance measurement from the real-world in order to-scale the cameras and the 
points to the real-world, 

• defining the world coordinate frame by providing the origin and a number of axes vectors, 

• seeing the 3D coordinates of the reconstructed points,

• making measurements between the reconstructed points.

 2.7.  Status Bar
Status bar is located at the bottom of the Tgi3D® CT Application Window. It displays information about current 
scaling, image size and status messages on selected menu items, clicked image locations etc.
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 3.  Menus
Menus contain the majority of Tgi3D® CT tools, commands, and settings. When clicked over it, each menu 
shows a drop down list containing a collection of related items. The list also contains icons of the identical 
buttons on the related toolbar as well as the shortcut keys for the same operations.  

Note:  Items in each menu could be enabled (highlighted) or disabled (get grayed out) depending on the 
current context. For example, Save menu item in the File menu will be grayed out until you make a change in  
the project.

The default menus in Tgi3D® CT are:

 3.1.  File
“File” menu contains items that relate to Tgi3D® CT project files. It includes commands to create, open, close, 
save, project files, and export calibration results, open most recent projects, and add images to, and remove  
images from the project.

 3.2.  Edit 
“Edit”  menu  contains  items  that  relate  to  the  editing  operations  that  include  editing  camera  database, 
preferences,  standard  undo-redo  commands and a toggle  switch for  enabling/disabling calibration point 
entries.

 3.3.  View
“View” menu contains items that relate to the viewing operations like zoom and rotation and showing/hiding 
project window and the image info window.

 3.4.  Tools
“Tools” menu contains camera calibration, model reconstruction and  and exporting functions.

 3.5.  Window 
“Window” menu mainly contains items for navigating through the images and the  3D model.

 3.6.  Help
“Help” menu contains items related to help and information on Tgi3D® CT.
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 4.  Toolbars
Tool bars appear below the menu bar. Each tool bar contain a set of related controls. To toggle the visibility of 
the tool bars, click the right mouse button on the menu bar and the tool bar area and check or uncheck the  
tool bar name from the context menu.

Note: Buttons on the tool bars get enabled (highlighted with color) or disabled (get grayed out) depending on 
the current context. For example, Save All button on the File tool bar will be grayed out until you make a 
change in the project.

Tgi3D® CT user interface includes the following tool bars:

 4.1.  File
“File” tool bar contains most commonly used menu items related to the Tgi3D® CT project files. These items 
are New Project, Open Project, Add Images, and Save All as shown in the figure below.

 4.2.  Edit
Firstly,  “Edit”  tool  bar  contains  buttons  for  standard  editing  operations,  namely  Undo  and  Redo.  The 
calibration related editing operations of deleting, marking and matching calibration points are located in this  
tool bar. It is also possible to show and hide projections of 3D reconstructed points using the “Show point  
projections” button. Building and viewing the resulting 3D model is the final command in the Edit toolbar.

 4.3.  Zoom
“Zoom” tool bar contains the tools to move the view in and out. These items in left to right order are: Zoom  
Box, Zoom In, Zoom Out, Fit to Screen, Normal Size, Zoom to selection, Magnifier and finally the zoom level  
for the magnifier used in marking points.
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 5.  File Menu 
The “File” menu contains items that relate to Tgi3D® CT project files. It includes commands to create, open, 
close, save projects, add images to the project, and export calibration results.

 5.1.  New Project...
“New Project...” menu item closes the current project and launches the Browse dialog box that allows you to 
create a new folder and open a new Tgi3D® CT project. The name of the selected folder is also the name of 
the project. 

Note:  If you have another project in the folder that is selected as a placeholder for the new project, that  
project is opened instead of creating a new one.

When a new project is opened, the name of the new project appears on the title bar and the project is empty 
at the beginning i.e. there are no images listed in the project window and the drawing and viewing area is  
empty. 

Keyboard Shortcut: Ctrl+N (Windows), command-N (Mac)

Toolbar Icon: 

 5.2.  Open Project....
“Open Project...” menu item closes the current project and launches the Open Project dialog box that allows 
you to select a previously saved project. Tgi3D® CT project file has the .prj extension.

When an existing project is opened, the name of the project appears on the title bar, the list  of images 
included in the project will be listed in the Project Window and the drawing and viewing area will show the  
images together with marked points.

Keyboard Shortcut: Ctrl+O (Windows), command-O (Mac)

Toolbar Icon:

 5.3.  Close Project
“Close Project” menu item closes the current project without closing the program. 

 5.4.  Add Images...
“Add Images...” menu item launches the Add Images dialog box that allows you to browse for and select the 
image files you want to add to the project. Tgi3D® CT supports the following image types: JPEG Image (.jpg), 
Windows  Bitmap  (.bmp),  Portable  Network  Graphics  (.png),  Graphics  Interface  Format  (.gif),  Portable 
Pixmap (.ppm) and Portable Graymap (.pgm).

Keyboard Shortcut: Ctrl+I (Windows), command-I (Mac)

Toolbar Icon: 

 5.5.  Remove Image from Project
“Remove Image from Project” menu item removes the current image from the project.

Caution: You cannot “undo” image removal. Once the image is removed from the project all the work done 
on that image will be lost.

 5.6.  Save
“Save” menu item saves the work done on the current image.
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Keyboard Shortcut: Ctrl+S (Windows), command-S (Mac)

 5.7.  Save All
“Save All” menu item saves all the work done in the project.

Toolbar Icon:

 5.8.  Export...
“Export..” menu item launches the Export Settings dialog box (See Section  22. for details). From this dialog 
box you  can  select  the  desired  output  format  and  the  image resolution  level  for  exporting  the  camera 
parameters, images and the reconstruction of points used in calibration.

Keyboard Shortcut: Ctrl+E  (Windows), command-E (Mac)

 5.9.  Exit 
“Exit” menu item closes the program. 

Note: On  Mac  OS X,  this  menu  item resides  under  the  Tgi3D  Calibration  Tool menu  as  “Quit  Tgi3D 
Calibration Tool” menu item instead.

 5.10. MRU Project List
For fast access, MRU (Most recently used) Tgi3D projects (at most five projects) are listed at the end of the 
“File” menu.
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 6.  Edit Menu
The “Edit” menu contains items that relate to the editing operations that include editing camera database,  
preferences and marking points, as well as the standard undo-redo commands.

 6.1.  Undo
“Undo” menu item takes back the last edit operation.

Keyboard Shortcut: Ctrl+Z (Windows), command-Z (Mac)

Toolbar Icon:

 6.2.  Redo
“Redo” menu item performs the last edit operation that was undone.

Keyboard Shortcut: Ctrl+Y (Windows), command-Y (Mac)

Toolbar Icon:

 6.3.  Clear Current Selection
“Clear current selection” menu item clears the selection in the current image

Keyboard Shortcut: Esc (Windows and Mac)

 6.4.  Clear all selections
“Clear all selections” menu item clears the selection in all the  images in the project.

Keyboard Shortcut: Ctrl+M (Windows), command-M (Mac)

 6.5.  Delete
“Delete” menu item deletes the selected point from the project.

Keyboard Shortcut: Del (Windows), Forward Delete (or fn-Delete) (Mac)

Toolbar Icon:

 6.6.  Camera Info...
“Camera Info...” menu item launches the Camera Info dialog box, where you can search and edit the sensor 
size parameters of  existing cameras and add new cameras to your  local  database,  which is set  in  the 
preferences dialog box. See Section 17. for detailed information.

 6.7.  Preferences...
“Preferences...” menu item launches the Preferences dialog box, where you can set the preferences related 
to memory and camera database and measurement unit. You can limit the number of images loaded into 
RAM and set/change the external user camera database file, and set a unit for displaying measurements.  
See Section 18. for detailed information. Also you can change the marker size.

Note: On Mac OS X, this menu item resides under the 'Tgi3D Calibration Tool' menu.

 6.8.  Calibration Point
“Calibration Point” menu item has a toggle feature used for enabling/disabling new calibration point insertion 
on photographs.  If  the  menu item is  in  checked state,  then  left  mouse  click  inserts  a  new unmatched 
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calibration point in the photograph at the cursor point. However this new calibration point will be active when 
it is matched with its counterpart calibration points in other photographs. Matching operation is activated by 
first selecting the corresponding points in different photographs and then clicking the right mouse button in 
one of the photographs containing a selected point. Once a point is matched it will be assigned a unique  
Matched Point ID available by pressing 'Q' key (or 'B' key if point is selected) on the keyboard. In order to  
unmatch the matched points, first press 'M' key on the keyboard and an overlayed window will be displayed 
on top left corner of the image window. Then click on the Matched Point ID to select all the matched points in  
the corresponding photographs. Then click on the right mouse button in one of these photographs and click  
the “Unmatch” button on the displayed dialog. If you want to assign a 3D coordinate to a calibration point 
(Note: 3D coordinate can only be assigned to matched calibration points), right click on the point (when there 
are no points selected in other photographs) and a 3D coordinate interface dialog box will open enabling a  
3D coordinate assignment to the calibration point. See Sections 12.1.,  12.1. and 12.4. for more information.

Keyboard Shortcut: Press and hold 'C' key (Windows and Mac)

Toolbar icon: 

 6.9.  Match points
“Match Points” menu item matches the points selected on all images to create a new calibration point.

Mouse Operation: Right click on a point

Toolbar icon: 

 6.10.  Assign 3D coordinate
“Assign  3D  coordinate”  menu  item  is  used  for  assigning  a  3D  coordinate  to  a  calibration  point.  This  
command is enabled when there no multiple selections.

Mouse Operation: Right click on a point
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 7.  View Menu
The “View” menu contains items that relate to the viewing operations like zoom and rotation on the image. 

 7.1.  Enable Mouse Wheel Zoom
“Enable Mouse Wheel Zoom” menu item is used to toggle the zooming ability via the mouse scroll wheel. If  
this  item is  checked in  the View menu,  you can zoom in  an out  on the image using the scroll  wheel,  
otherwise the mouse-wheel is used for vertical scrolling.

 7.2.  Orthographic View
“Orthographic View” menu item is used in 3D viewer. You can toggle between orthographic and perspective 
views by checking or unchecking this menu item. If  the model is not yet reconstructed this item will  be  
disabled (not selectable) in the View menu. In the orthographic view, parts of the object are always the same 
size no matter how far away they are as opposed to perspective view where parts that are farther away are 
smaller. The default view is the perspective view.

 7.3.  Rotate Left
“Rotate Left” menu item rotates the image to the left by 90 degrees. 

 7.4.  Rotate Right
“Rotate Right” menu item rotates the image to the right by 90 degrees. 

 7.5.  No Rotation
“No Rotation” menu item is used to revert the image rotation back to its original orientation.

 7.6.  Zoom Box
“Zoom Box” menu item is used zoom the image to a rectangular area selected by the user. After selecting the 
menu item, the program is in zoom box mode, where the user can draw a rectangular area to zoom in the  
picture by clicking the left mouse button and dragging the mouse while keeping left mouse button clicked.

Keyboard Shortcut: Press and hold 'Z' key (Windows and Mac)

Toolbar Icon:

 7.7.  Normal Size
“Normal Size” menu item is used to zoom the image to its actual dimensions.

Keyboard Shortcut: 0 (zero) (Windows and Mac)

Toolbar Icon:

 7.8.  Zoom In
“Zoom In” menu item zooms in to the image.

Keyboard Shortcut: + (Windows and Mac)

Toolbar Icon:
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 7.9.  Zoom Out
“Zoom Out” menu item zooms out of the image.

Keyboard Shortcut: -  (Windows and Mac)

Toolbar Icon:

 7.10. Fit to Screen
“Fit to Screen” menu item resizes the image view to fit to the viewing area.

Keyboard Shortcut: . (dot) (Windows and Mac)

Toolbar Icon:

 7.11.  Zoom to Selections
“Zoom to Selections” menu item zooms all the views to the selections in all the images of the project.

Toolbar Icon:

 7.12.  Show point projections
It is possible to show and hide projections of 3D reconstructed points using the “Show point projections” 
menu item.

Toolbar Icon: 

 7.13.  Show matched points
“Show matched points” command displays a list of calibration point ids (i.e. Matched Point IDs) on the top left 
corner of the viewer window. 

Keyboard Shortcut: Press and hold 'M' key (Windows and Mac) 

 7.14.  Show selected point info
“Show selected point info” command displays the id of the selected point in the current image by the point 
marker.

Keyboard Shortcut: Press and hold 'B' key (Windows and Mac)

 7.15.  Show all point infos
“Show selected point info” command displays the ids of all the points in the current image by their markers.

Keyboard Shortcut: Press and hold  'Q' key (Windows and Mac)

 7.16.  Hide point markers
“Hide  point  markers”  command hides  the  markers  of  the  points  on  the  images  so  that  the  underlying 
photographs can be inspected without interference

Keyboard Shortcut: Press and hold 'W' key (Windows and Mac)
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 7.17.  Magnifier
“Magnifier” menu item displays information on how to use the magnifier. In order to activate the magnifier  
over the cursor location, you need to press and hold the 'Shift' key inside image area. Releasing 'Shift' key  
closes the magnifier.

Toolbar Icon: 

Keyboard Shortcut: Press and hold 'Shift' key (Windows and Mac)

 7.18. Magnifier magnification
You can change the magnification ratio of the magnifier using this spin box. 

Toolbar Icon: 

 7.19. Project Window
“Project Window” menu item shows or hides  the Project Window.

 7.20.  Show Image Info
“Show Image Info” menu item show or hides the “Image Info” sub-window inside the Project window.
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 8.  Tools Menu
The “Tools” menu contains functions that relate to camera calibration and model reconstruction operations.

 8.1.  Build 3D Model
“Build 3D Model” menu item reconstructs the calibration points and launches the 3D viewer to display the 
calibration points in 3D.

Keyboard Shortcut: Ctrl+R  (Windows), command-R (Mac)

Toolbar Icon: 

 8.2.  Camera Calibration...
“Camera Calibration...” menu item launches the  Camera Calibration Settings dialog box (see Sections 19. 
and 20.), which contains the settings to be used during the camera calibration process. Clicking the “Run” 
button on this dialog executes the camera calibration process according to the given settings.

 8.3.  Export...
“Export..” menu item launches the Export Settings dialog box  (see Section  22. for details). From this dialog 
box you can select the desired output format for exporting the camera parameters and the reconstruction of  
points used in calibration.

Keyboard Shortcut: Ctrl+E  (Windows), command-E (Mac)
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 9.  Window Menu
The “Window” menu contains items to change the display of the windows used in the Drawing and Viewing  
Area.

 9.1.  Close 3D Model
“Close 3D Model” menu item closes the 3D Model window.

Keyboard Shortcut: Ctrl+F4  (Windows), command-F4 (Mac)

 9.2.  Last Active
“Last Active” menu item toggles between the last active and current image window (or tab).

Keyboard Shortcut: Ctrl-Tab or Ctrl+T (Windows), ctrl-Tab or command-T (Mac)

 9.3.  Next
“Next” menu item activates the next tab (or window) in the Drawing and Viewing Area.

Keyboard Shortcut: Right, Down or Ctrl+plus (+) (Windows), Right, Down or command-plus (+) (Mac)

 9.4.  Previous
“Previous” menu item activates the previous tab (or window) in the Drawing and Viewing Area.

Keyboard Shortcut: Left, Up or Ctrl+minus (–) (Windows), Left, Up or command-minus (–) (Mac)

 9.5.  (image list)
At the end of the “Window” menu the names of image files included in the project is listed. Selecting the 
menu item with a specific image file name activates the image file (i.e. brings it on top ready to be worked  
on). For the first 10 items in the list, a set of short cut keys are also provided according to the position of the  
image file in the list.

Keyboard Shortcut: Ctrl+(a number between 0 and 9) (Windows), command-(0-9) (Mac) 
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 10.  Help Menu
The “Help” menu contains items related to getting help with Tgi3D® CT.

 10.1.  Help
“Help” menu item launches the help document.

 10.2. Check for updates
“Check for updates” menu item connects to the internet and checks if any update is available.

 10.3.  About...
“About...” menu item launches the About Tgi3D® CT dialog box which displays information about version of 
the program, licensing and copyrights.

Note: On Mac OS X,  this  menu item resides under the  Tgi3D Calibration Tool menu as “About  Tgi3D 
Calibration Tool” menu item instead.
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 11.  Project Window
The “Project Window” facilitates navigation through the images used in the project and provides information 
on the current status of the calibration project. It has three pages: “Photo files”, “Point errors” and “3D model” 
and a sub-window that shows and allows editing of  image information as shown below.

 11.1.  Photo files
“Photo Files” page lists the photographs used in the project. The file extensions of the images are stripped 
and the each image corresponds to a camera to be calibrated.  Additional  indicator  text  may follow the 
camera name according to the state of the system:

• (C) : Indicates a calibrated camera.

• (D) : Indicates a disabled camera

• (L) : Indicates a locked camera

• (p+) : Indicates that a point is selected in the corresponding photograph.

• * : Indicates that there are unsaved modifications made on the photograph or points.

You can can select an image (or navigate through the images) using a single click of the left mouse button.  
You can also navigate through the images using the Left-Right and Up-Down keys. Active window in the  
Drawing and Viewing Area will switch to the selected image in the list.

 11.2.  Point Errors
“Point  Errors”  page  lists  the  calibration  points  with  high  projection  errors.  For  each  point  the  highest 
projection error  and errors  on each camera are displayed.  Selecting a camera displays the image and 
selects the point in the drawing and viewing area. High error rates indicate poor calibration quality and is the  
result of bad or even false localization of calibration points on each image. You may determine such badly 
placed points using the point error page. The point error list contains at most 10 calibration points that have 
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high calibration errors.

 11.3.  3D Model 
“3D Model” page contains a a list of images similar to the “Photo Files” page, but this time they facilitate  
switching to the camera corresponding to the selected image in 3D view of the reconstructed points. The 
image is also placed in the background so that the 3D calibration points can be viewed overlayed on the 
image. An additional item “Camera-free” refers to an arbitrary view without any background images. See  
Section 13. for details.  

 11.4.  Image Info
“Image Info”  sub-window is  displayed at  the bottom side  of  the  project  window.  It  contains the 
information  about  the  image and  the  camera  used  to  take  the  picture  and  the  state  of  the  camera  in  
calibration process. If the photograph EXIF information exists then the camera related is read-only. If the 
camera  in  the  EXIF information  can  be  found  in  the  built-in  or  local  database,  its  sensor  size  will  be  
displayed; otherwise it is going to be assumed to be a typical point a shoot camera. In order to override this 
assumption,  you  need  to  enter  required  information  using  the  Camera  Info dialog  box,  which  can  be 
activated using the “Search in DB” button in the sub window or the Camera Info menu item in the Edit menu.

If  the image does not  include any EXIF information,  you will  be allowed to  choose a camera from the 
database by filling in the make and model fields and pressing the “Search in DB” button. If the camera can 
be found in the database the correct sensor size will be displayed otherwise the Camera Info dialog box will 
show up to let you enter a new camera with the make and model you provided. If you do not want to create a  
new camera or choose an existing one, just enter an estimate of the focal length for a typical point and shoot  
camera, which is assumed to has 10 mm wide sensor. If you don't enter anything a default focal length is  
supplied by the program.
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Note: The sensor size does not have to be accurate since calibration tool can compute the actual  
ratio (sensor size)/(focal length). The sensor width and height together with the focal length are used 
as initial guesses for the ratio, and calibration tool is able to compute the correct values even with 
30% initial error.

                          (a) EXIF info exists                                            (b) EXIF info does not exist

The fields
• Image: The name of the image file.

• Width: The width of the image.

• Height: The height of the image.

• Make: The producer company of the camera.

• Model: The model of the camera.

• Focal length: The focal length of the camera.

• Sensor width: The width of the sensing area of the camera.

• Sensor height: The height of the sensing area of the camera.

• Disabled: Check this option to prevent the camera to be included in the calibration process

• Locked:  Check this option to prevent the camera to freeze the calibration parameters of the camera 

The Command Buttons
• Search in DB:  Search the camera given in the make and model fields in the built-in and local  

database. If it is found, the sensor size fields are filled in automatically; otherwise the Camera Info 
dialog box (see Section 17.) to enter a new camera or select an existing one.  

• Update: Update the camera information
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 12.  The Image Viewer
Image viewer displays the image and allows manipulation of calibration points on each image. The basic 
drawing  operation  in  this  viewer  is  creating  calibration  points  to  be  used  in  camera  calibration  and 
reconstruction of the real world. A calibration point refers to a unique point in 3D space. This point can have 
projections on the images in the project. For example, the corner of a table is a calibration point in 3D and its  
projections are its 2D location on the photographs that see the corner. In the image viewer, the projections 
are marked on each image and then, they are matched to let the system know that the selected points at the  
moment refer to the same calibration point. Because of this equivalence, we refer both the point itself and its  
projections as calibration point.

The calibration points are displayed with a small  red marker as shown below. A highlighted red marker  
indicates a  selected  point.  Matching the selected points,  browsing and selecting calibration  points,  and 
manipulating  the  markers  are  the  basic  operations  available  in  the  image  viewer.  Various  mouse  and 
keyboard actions are utilized for the manipulation of the markers, thus the calibration points.

 12.1.  Manipulating Calibration Points
Adding, moving, selecting, and deleting calibration points are the main editing tasks in the image viewer. You 
can also enter real-world coordinates of the points if available. 

To add a calibration point:

1. Use, “Calibration point” toggle item in the Edit menu or the toolbar, or just press and hold the 'C' key 
on the keyboard.

2. A left mouse click on the photograph places a calibration point marker at that location.

To select a point: 

1. A left mouse click on its marker selects the point 

To delete a point:

1. Select it

2. Press 'D' or 'Del' key on the keyboard, or use the “Delete” menu or toolbar item.

To move a point:

1. Drag (click, hold and move) the point using left mouse button.

To enter 3D coordinate for a calibration point:

1. Right click on one of its projection, when there are no selected points on other frames

2. Fill in the coordinate field in the 3D Value dialog box (see Section 14.) that shows up.  
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 12.2. Matching Calibration Points
In order to reconstruct a 3D point, it should be visible on at least two cameras, therefore the marker points on  
the images are of no use if they are not matched to any point on another photograph. Matching points lets  
the system know that the matched points are the projections of a unique 3D point in space.

To match points:

1. Select the points to be matched on the photographs

2. Right click on one of them (or inside the photograph)

3. Click on Match button in the Match/Unmatch Selected Points dialog box that shows up.

Unmatching a group of points is handled through the “Calibration Point List”.

 12.3. Matching Projections of 3D Points
It is also possible to create matching points using the projection of a point in the 3D model on a calibrated  
camera. This operation help increase the accuracy of the calibration. Make sure the “Show point projection”  
item in the Edit toolbar and the view menu is checked. If a point in the model does not have a matching point 
on an input image then its projection is displayed with a yellow marker. For matching point creation

1. Click on the yellow marker to select all the matching points of the corresponding 3d point on the rest 
of the images.

2. Check the existing projections to see the corresponding feature in the scene.

3. Click on the marker again to add the point as the matching point for the feature.

4. Drag the point to the center of the corresponding feature.

 12.4. Calibration Point List
Pressing 'M' key on the keyboard displays a list of calibration point ids (i.e. Matched Point IDs) on the top left 
corner of the viewer window. The list stays there as long as the key is pressed. Left-clicking on any of the ids 
causes all the projections of the corresponding point to be selected. These selections can be tracked using 
the 'p+' text on the label of the image in the projection window or the selection tab.
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To unmatch a group of points or equivalently delete a calibration point in the list

1. Select it in the overlayed “calibration point list” window

2. Right-click on one of the points on the images

3. Press “Unmatch” button in the Match/Unmatch Selected Points dialog box that shows up

 12.5.  The Magnifier
Precise localization of calibration points on the image requires the use of high zoom levels, on the other hand 
finding a matching point on another image may requires a lower zoom level where a large part of the image  
is visible to avoid false matches. For example in case of table or a desk one should be able to look at the  
whole table and the surroundings to locate the same corner on all the images; then zoom at that corner to be  
able to mark it with sub-pixel precision. The magnifier is a small size rectangular window, that pops up on the 
image view area and shows the image at a higher zoom level than the base viewer, as shown in the figure 
below. The amount of magnification is determined by the magnification ratio spin-box on the zoom tool bar 
(see Section 4.3.).  The mouse and keyboard control  for zooming,  panning,  editing etc.  of  the magnifier 
content is similar to the image viewer, with a few limitations. You can think of it as a small size image viewer. 

Press and hold the 'Shift'  key to show the magnifier. When the key is pressed it will show up centering the 
current mouse location but you can drag it over the image using the right mouse button.
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 12.6. Mouse and Keyboard Actions
Mouse and keyboard actions available on the Drawing and Viewing Area are listed below.

 a) Left Mouse Button

The left mouse button has the following functions:

• Select a point: You can select a point by clicking close to that point

• Moving a point: Click, hold and move the cursor to move a point over the image.

• Add new point: If the calibration point mode is activated from the menu or the tool bar or if the 'C'  
key is pressed, clicking on an empty point  on the image creates a new calibration point at that 
location.

 b) Middle Mouse Button

• Panning: When the image is displayed at a zoom level that does not fit in the viewer window, drag 
(click, hold and move) the image using the middle button to see the other parts of the image.

 c) Mouse Wheel

• Zooming: Moving the wheel allows you to zoom in and out when  “Enable Mouse Wheel Zoom” 
menu item is checked or used inside the magnifier. Mouse wheel also works as vertical scroll when 
“Enable Mouse Wheel Zoom” menu item is unchecked.

 d) Right Mouse Button

The function of right mouse button depends on the selected points on the current image and other images 
and inside the magnifier..

• Match/Unmatch selected points:  If there selected points on other photographs, right clicking on 
any of the selected points launches the Match/Unmatch Selected Points dialog box where you can 
match, unmatch, or deselect the selected points.

• Enter/Remove 3D Point value: If there are no multiple selections, right-clicking on a point, that has 
a match on at least one more image, allows you to enter a 3D coordinate for the corresponding 
calibration point.

• Drag the magnifier: You can move the magnifier by right-clicking on it,  holding and moving the 
mouse cursor. 

 e) Keyboard Commands

• 'D' or Del : Delete a selected point.

• 'M' : Display a list of calibration points (i.e. matched points) visible on that image.

• 'B' : Display the id of the selected point.

• 'Q' : Display the id of all the points on the image.

• 'W' : Hide all the points on the image so that the underlying photographs can be inspected without  
interference

• 'Z' : Box zoom mode is active as long as the key is pressed.

• 'C': Calibration point mode is active as long as the key is pressed.

• Esc: Clear the selection

• Shift: The magnifier is shown as long as the key is pressed. 
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 13.  The 3D Model Viewer
The 3D Model viewer displays the reconstructed points in 3D and allows entering a distance measurement  
from the real-world in order to scale the cameras and the point reconstructions to fit the real-world, see the  
3D coordinates of the reconstructed points and make measurements between the reconstructed points and 
define a world coordinate system by entering an origin and vectors parallel to the world frame axes.

 13.1.  Calibrated Camera Views
Selection tabs and the “3D Model” page in the project window (both containing entries corresponding to the 
calibrated cameras) enable switching between the 3D views of the calibrated cameras. When an entry is 
selected,  the  3D  viewing  camera  is  set  to  the  parameters  of  the  corresponding  camera  and  the 
corresponding image is set to be the background so that the 3D points are overlayed on the image as shown 
in the figure below. 

The overlayed view lets you 

1. Identify calibration points

2. Make meaningful measurements in the scene. 

3. See the difference between the projection of reconstructions and the corresponding feature, to get 
an idea about the quality of calibration. 

4. Correctly locate a feature in an image where it  can not be easily found due to the presence of  
periodic structures or very large shifts in locations due to wide angular differences between cameras.
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To switch to a camera view: Select the camera entry in either one of 

• 3D Model page in Project window

• Selection tabs above the view

 13.2.  Camera-Free Views
It is also possible to see the reconstructed points freely from an arbitrary viewing angle different from the 
calibrated cameras as shown in the figure below. 

The points are displayed as yellow dots on a black background. Middle mouse button and wheel is used for 
this purpose. 

To change the viewing angle: Drag using the middle mouse button.

To change the zoom level: Use the mouse wheel.

 13.3. Coordinates of the reconstructed points
In both types of views if the mouse cursor stands close to a reconstructed point for about a second, a small  
windows pops-up  to display the position of the reconstructed point in 3D space.

 13.4.  Real-world Measurements and the World Coordinate System
As it  is  impossible  to  know the  scale  of  the  world  from photographs,  the  point  and  camera  locations 
computed in the calibration process are correct up to a scale factor.  If you want to build models without any 
scale and coordinate system ambiguity ambiguity or make real measurements using Tgi3D® CT, you need to 
resolve the scale ambiguity. 
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Another ambiguity arising in the calibration process is the coordinate system of the reconstructed world. If  
you want to have control over the world coordinate system, you need to set an origin and directions of X, Y 
and Z axes. 

Entering the real world coordinates of calibration points as described in Sections 12.1. and 14. is one way to 
resolve  the ambiguities mentioned above.  Setting two point  coordinates is  enough to  resolve the scale 
ambiguity. Entering the third point coordinate will completely define the world coordinate system.

The 3D model view lets you control the world coordinate system in an easier way by

1. Entering  the  distance  between  two  points   through  the  Measurement  Result dialog  box  (see 
Section  15.)

2. Setting one of the calibration points as the origin of the world.

3. Setting a vector between two points as parallel to one of the X, Y, and Z axes.

To enter a real world measurement or set axes constraints:

1. Right click on a point in the 3D model. The point turns magenta after clicking.

2. Right click on the second point. A magenta line is drawn between the two points and a context menu 
shows up containing 

• the current value of the distance between the two points and a command for editing it,

• commands for setting the vector between the points parallel to one of the wold coordinate frame 
axes

as shown in the figure below:

3. If you select the “Edit” command the Measurement Result dialog box (see Section 15.)pops up to let 
you enter the real world distance between the two points. 
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Note: Only one measurement can be saved for a 3D model; therefore the previous measurement 
value is lost, when the current measurement is saved.

4. If  you select one of the axes, the vector between the points is used as a constraint in the next 
camera calibration process. 

Note: You can set as many vectors as you like to be parallel to the any of the axes as long they are 
not  incompatible with each other.

5. Click the “Edit” button in the dialog box

To set the origin of the world coordinate system:

Do one of the following:

• Right double click on the point you want to set as the origin.

• Apply two clicks on the same point as if you are making a measurement. A context menu for setting  
the origin will show up.

Note: Only one point can be set as an origin therefore your previous origin setting will be overwritten with the 
new origin.

To delete a measurement, axis or origin:

1. Right click on the constraint you want to delete

2. Select delete in the constext nmenu that shows up.

 13.5.  Mouse Actions

 a) Left Mouse Button

• Use the left mouse button to select points. When a calibration point is selected it is displayed in red 
and all of its projections on the photographs are selected as well. 

 b) Middle Mouse Button

• Dragging using the middle mouse button changes the viewing angle. 

 c) Mouse Wheel

• Moving the wheel allows you to zoom in and out in the current view 

 d) Right Mouse button

• Right click on two consecutive points to display  enter real world measurements, world origin and 
axes constraints.

• Right  click  on  the  real-world  measurement,  axis  constraint  or  origin to  edit  the  corresponding 
distance measurement, or axis constraint

30



 14.  3D Value Dialog Box
3D Value dialog box is used to enter a 3D coordinate in specified units for a calibration point.

The following are the actions associated with 3D Value dialog box:

• Point value and unit: Enter the X Y Z coordinates separated by space or commas of the point in the 
“Value” field and choose the unit from the combo box beside it 

• Set: Click “Set” button to set the 3D coordinate of the selected point

• Remove: Click “Remove” button to remove the 3D coordinate associated with the selected point.

• Cancel: Click “Cancel” button to close the dialog box without changing anything.
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 15.  Measurement Result Dialog Box
Measurement Result dialog box is used to display and set the distance between two selected points in the 
3D model. To enter or edit a measurement

• Enter the measurement value in the distance field and choose the unit.

• Click  save  to  save  the  measurement.  Only  one  measurement  can  be  saved  for  a  3D model;  
therefore the previous measurement value is erased, when the current measurement is saved. 
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 16.  Match/unmatch Selected Points Dialog Box
Match/unmatch  Selected  Points dialog  box  shows  up  when  there  are  selected  points  on  multiple 
photographs. It is only used to issue the following commands:

• Match: The selected points are matched, which means that the selected points are the projections 
of the same 3D point in the scene.

• Unmatch: The unmatch command is active only when the points are selected using Calibration 
point  list  sub-window in  the  image  viewer  (see  Section 12.4.).  The  points  are  unmatched  or 
equivalently the 3D calibration point associated with the matches is removed. 

• Deselect:  The deselect command is active only when the points are selected using Calibration 
point list sub-window in the image viewer (see Section 12.4.). The points on all the photographs are 
unselected with this command.

• Cancel: Close the dialog box without doing anything.
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 17.  Camera Info Dialog Box
Camera Info dialog box lets you search and edit the sensor size parameters of existing cameras and add 
new cameras to your local database, which is set in the Preferences dialog box (see Section 18.). Tgi3D® CT 
comes with a built-in database including information on more than a thousand cameras. If your camera is not 
included in the database (you can check that using the “Locate in DB” button in the dialog box) then you  
need to enter and save the make, model and the sensor size parameters of your camera. Typically you can 
find that information through the internet or from the camera manual. The make and model should be similar  
to the make and model parameters provided in the EXIF section of the digital images taken by your camera.  
Knowing the sensor size allows the calibration tool interpret the focal length information provided in the EXIF 
section correctly.

The fields
• Make: The producer company of the camera.

• Model: The model of the camera

• Sensor width: The width of the sensing area of the camera

• Sensor height: The height of the sensing area of the camera

Command Buttons
• Locate in DB: Use this button after filling in the Make and Model fields.  The given camera is 

searched in the database (both the local and the built-in database). If the camera is found, the make 
and model registered in the database is displayed in the text box on the left side of the button; and 
the sensor width and height fields are filled in; otherwise “Unknown camera” is displayed.

• Save: Update or save the camera information provided to the local database.

• Save and Select: This button shows up when the dialog box is launched from the Image Info dialog 
box (see Section). Apart from saving, the current record is selected to fill in the camera fields in the 
Image Info dialog box. 

• Delete: Delete the camera if it is found to be in the local database. 

• Cancel: Close the dialog box without doing anything.
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 18.  Preferences Dialog Box
Preferences dialog box contains options to set the preferences related to image viewer, memory, camera 
database and measurements. You can set the size of markers to display points, limit the number of images 
that are kept in RAM, choose to include camera info from an external file saved in another Tgi3D® CT project 
and set the preferred unit for displaying measurements.

Settings Related to Image Viewer
You can specify the size of the matching point markers (i.e. the plus sign) in pixels.

Settings Related to Memory
Tgi3D® CT keeps a number of images in RAM for faster access to speed up the user interaction on the  
images. The following settings on the Preferences dialog box allow you to set them.

• Maximum Loaded Images:  Specifies the maximum number of images to be kept in computer's 
RAM for faster access during editing operations.

• Maximum Loaded Images (3D Model):  Specifies the maximum number of images to be kept in 
computer's RAM for faster access during 3D viewing of the reconstructed model.

Depending on the size of your computer's RAM you can increase or decrease the number of images to be  
kept in RAM.   

Settings Related to Database
Tgi3D® CT has an extensive internal camera database that recognizes more than 1300 cameras available in  
the market, however considering the very large and rapidly changing market there is a possibility that your 
camera may not be included in the built-in database. In that case, you can define and save new camera 
models in a file determined by the user camera database setting.
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Settings Related to Measurements
Tgi3D® CT can display the distance between any pair of calibration points. The preferred measurement unit 
setting allows you to set the desired unit for displaying measurement results.
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 19.  Camera Calibration Settings Dialog Box
Camera Calibration Settings dialog box contains the settings to be used in the camera calibration process. 
After setting the options click “Run” button to calibrate the system. It is possible to view a report on the  
calibration process and also switch to the advanced calibration mode within this dialog box.

Calibration Options
• Create calibration uncertainty (or accuracy) information: You need to check this options if you 

want the measurements to be reported with uncertainty information (95%, i.e 2 , confidence interval 
is used in reporting uncertainties). Checking this options causes a slightly slower camera calibration.

• Ignore previous calibrations: Check  this  option if  you  want  the  calibration  process  start  from 
scratch  ignoring  the  previous  camera  calibration  results.  In  a  typical  project  you  may  want  to  
calibrate the system every time you add a calibration point or add new images to the project. We 
recommend ignoring the previous calibrations every now and then to avoid the system trapping at a 
local minima.

Command Buttons
• Run: Executes the calibration process.

• View report: See an evaluation of the calibration results by clicking the “View Report” button. The 
report provides information on the estimated internal parameters of the cameras calibration results  
and accuracy.

• Advanced: Launch the Advanced Calibration Settings dialog. Advanced calibration is meant to be 
used in case of difficult calibration projects, where the EXIF or similar information on the camera 
parameters is not available or the available calibration points results in a semi-stable system.

Note: The best way to cope with calibration failures is to provide more and more calibration points  
visible on as many cameras as possible. Advanced calibration is the very last resort meant for users  
with basic technical knowledge on image formation and parameter estimation process.

• Cancel: Cancel the calibration process and close the dialog box.

37



 20.  Advanced Camera Calibration Settings  Dialog Box
Advanced Camera  Calibration  Settings dialog  box  contains  some  options  to  be  used  in  the  camera 
calibration process. These setting refer to the focal length estimation, calibration refinement process, radial  
distortion estimation and the basic parameters of calibration explained in the  Camera Calibration Settings 
dialog box (See the previous section for the explanation of these parameters). After setting the options click  
“Run” button to  calibrate  the system.  The dialog box contains command buttons for  saving the current  
calibration parameters, viewing the report or the log file of the calibration process. It is also possible to save  
the  estimated  focal  and radial  distortion  to  the  camera  database  for  re-using them in  other  calibration  
projects.

Note: Option changes here are only effective for advanced camera calibration run! Basic camera calibration 
run is not affected by option changes here.

Settings Related to Focal Length
• Default focal length: The default focal length is an initial estimate of the unknown focal lengths. 

This parameter applies to the cameras, whose corresponding image files do not contain any EXIF 
information and the user did not provide a value through the Image Info dialog box.

• Fix focal length: If the “Fix focal length” option is checked, then the camera calibration process 
does not estimate focal length, instead uses the initial estimate provided in the EXIF info, or the  
value user provided through the Image Info dialog box or the default value entered in this dialog box. 

Settings Related to Refinement
• Recalibration count:  In the final stage of camera calibration the system goes through an bundle 

adjustment process for the refinement of estimated parameters. The refinement count determines 
the number of refinements to be applied. Ideally one refinement step is enough to reach to a local  
minimum, but in case of a shallow minimum the process could be repeated to get the system to a  
better state. 10 should be enough for most cases. If you increase this number much above 100, then 
the calibration process will take a long time to finish.

38



Settings Related to Radial Distortion
• None: It is assumed that there is no radial distortion on the images

• Estimate: Estimate the radial distortion in the images

• Use previous: Set the radial distortion parameters to the previously estimated value and do not re-
estimate.

Command Buttons
• Run: Executes the calibration process.

• Save: Saved the current calibration parameters for future use

• Cancel: Cancel the calibration process and close the dialog box.

• View Report: See an evaluation of the calibration results by clicking the “View Report” button. The 
report provides information on the estimated internal parameters of the cameras calibration results  
and accuracy.

• View Log: The calibration process produces a log file located in the project directory. It is meant to  
be used by the developers for debugging purposes.

• Save current calibration to camera database: This command saves the estimated focal length 
and radial distortion parameters to the camera database. This option is useful only if you will be  
using the same camera with exactly the same lens at the same focal length in many other projects.
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 21.  Calibration Report
The calibration report provides information on the estimated internal parameters of the camera calibration  
results and accuracy. It consists of three sections:

• Internal parameters: The focal length and the radial distortion of each camera are reported in this 
section. The radial distortion is reported as the radial shift in pixels at a specific radius to give an  
intuitive idea on the strength of radial distortion. The sign indicates the direction of radial shift.

• Calibration Error: When the cameras are calibrated the calibration points are reconstructed. Due to 
the unavoidable error in calibration point locations on images the reconstruction will not project on 
exactly the marked locations. The difference between the projection of reconstructed points and the 
marked points is an indicator of calibration quality. The average projection on each camera and the 
overall projection error is reported in this section.

• User Error: User error rate is the prediction of the uncertainty in point locations. It depends on the 
user and the quality (e.g. sharpness) of features.
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Camera Calibration Results

Camera SDIM6912: SIGMA SIGMA SD14
     focal length: 67.2027 radial (r = 1320 pix): -2.74364
Camera SDIM6913: SIGMA SIGMA SD14
    focal length: 67.2027 radial (r = 1320 pix): -2.74364
Camera SDIM6914: SIGMA SIGMA SD14
    focal length: 67.2027 radial (r = 1320 pix): -2.74364
Camera SDIM6915: SIGMA SIGMA SD14
    focal length: 67.2027 radial (r = 1320 pix): -2.74364
Camera SDIM6916: SIGMA SIGMA SD14
    focal length: 67.2027 radial (r = 1320 pix): -2.74364
Camera SDIM6917: SIGMA SIGMA SD14
    focal length: 67.2027 radial (r = 1320 pix): -2.74364

Projection error over 6 cameras and 14 / 14 points.
Average Error SDIM6912 = 0.191028 over 10 points.
Average Error SDIM6913 = 0.165243 over 12 points.
Average Error SDIM6914 = 0.142597 over 13 points.
Average Error SDIM6915 = 0.210634 over 10 points.
Average Error SDIM6916 = 0.146645 over 10 points.
Average Error SDIM6917 = 0.241007 over 11 points.
Global Average Error = 0.181376

Predicted user error: 0.313767

.
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 22.  Export Settings Dialog Box
Export  Settings dialog box allows you to select  an output  format,  image resolution level  and determine 
whether  the  reconstructed  points  will  be exported.  Currently  exporting the  calibration  points  and image 
resolution is an active option only for SketchUp and Tgi3D format. In exporting to SketchUp, the cameras are  
used to create the “Photo-Match” pages which lets you draw over the images.  If the “ Include calibration 
points“option is checked, reconstructed points used in camera calibration are exported as well. The image 
resolution determines the size of of the images to be used in the photo-match pages.. The Tgi3D format is an 
internal format to be used by other Tgi3D products. It contains the camera parameters, the reconstructed  
points and the radially undistorted images.

For other formats, the calibration points are the only entities that are exported; therefore the option is always 
checked. The images are not exported at all.

Export Options
• Output Format: The output format combo box lists the currently available output formats for export.

• Include calibration points: If  you check this  option the reconstructed calibration points  will  be 
exported.

Command Buttons
• Run: Prompts for a file name and  executes the export process. 

• Cancel: Cancel the export and close the dialog box.
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